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HP SOFTWARE PRODUCT LICENSE AGREEMENT

Important: Please carefully read this License Agreement before operating the equipment. Rights in the
software are offered only on the condition that the Customer agrees to all terms and conditions of the
License Agreement. Operating the equipment indicates your acceptance of these terms and conditions. If
you do not agree to the License Agreement, you may return the unopened package for a full refund.

In return for payment of the applicable fee, HP grants the Customer a license in the software, until termi-
nated, subject to the following:

Use:

*  Customer may use the software on any one computer.

+  Customer may not reverse assemble or decompile the software.

Copies and Adaptations:

»  Customer may make copies or adaptations of the software:
*  For archival purposes, or
*  When copying or adaptation is an essential step in the use of the software with a computer so long

as the copies and adaptations are used in no other manner.

*  Customer has no other rights to copy unless they acquire an appropriate license to reproduce which is
available from HP for some software.

e Customer agrees that no warranty, free installation, or free training is provided by HP for any copies
or adaptations made by Customer.

*  All copies and adaptations of the software must bear the copyright notice(s) contained in or on the original.

Ownership:

«  Customer agrees that they do not have any title or ownership of the software, other than ownership
of the physical media.

* Customer acknowledges and agrees that the software is copyrighted and protected under the
copyright laws.

HP Sofrware Product License Agreement  iii



* Customer acknowledges and agrees that the software may have been developed by a third
party software supplier named in the copyright notice(s) included with the software, who shall be
authorized to hold the customer responsible for any copyright infringement or violation of this
License Agreement.

Transfer of Rights in Software:

*  Customer may transfer rights in the software to a third party only as part of the transfer of all their rights
and only if Customer obtains the prior agreement of the third party to be bound by the terms of this
License Agreement.

*  Upon such a transfer, Customer agrees that their rights in the software are terminated and that they will
either destroy their copies and adaptations or deliver them to the third party.

*  Transfer to a U.S. government department or agency or to a prime or lower tier contractor in connection
with a U.S. government contract shall be made only upon their prior written agreement to terms required
by HP.

Sublicensing and Distribution: Customer may not sublicense the software or distribute copies or adapta-
tions of the software to the public in physical media or by telecommunication without the prior written

consent of HP.

Termination: HP may terminate this software license for failure to comply with any of these terms provided HP
has requested Customer to cure the failure and Customer has failed to do so within thirty (30) days of such notice.

Updates and Upgrades: Customer agrees that the software does not include updates and upgrades which
may be available from HP under a separate support agreement.

Export Clause: Customer agrees not to export or re-export the software or any copy or adaptation in viola-
tion of the U.S. Export Administration regulations or other applicable regulations.

iv  HP Software Product License Agreement



HP SHRINKWRAP LICENSE TERMS

The following License Terms govern your use of the accompanying Software unless you have a separate
signed agreement with HP.

License Grant: HP grants you a license to use one copy of the Software. “Use” means storing, loading,
installing, executing or displaying the Software. You may not modify the Software or disable any licens-
ing or control features of the Software. If the Software is licensed for “concurrent use”, you may not allow
more than the maximum number of authorized users to Use the software concurrently.

Ownership: The Software is owned and copyrighted by HP or its third party suppliers. Your license
confers no title to, or ownership in, the Software and is not a sale of any rights in the Software. HP’s third
party suppliers may protect their rights in the event of any violation of these License Terms.

Copies and Adaptations: You may only make copies or adaptations of the Software for archival purposes
or when copying or adaptation is an essential step in the authorized Use of the Software. You must repro-
duce all copyright notices in the original Software on all copies or adaptations. You may not copy the
Software onto any public network.

No Disassembly or Decryption: You may not disassemble or decompile the Software unless HP’s prior
written consent is obtained. In some jurisdictions, HP’s consent may not be required for limited disassem-
bly or decompilation. Upon request, you will provide HP with reasonably detailed information regarding
any disassembly or decompilation. You may not decrypt the Software unless decryption is a necessary part
of the operation of the Software.

Transfer: Your license will automatically terminate upon any transfer of the Software. Upon transfer, you
must deliver the Software, including any copies and related documentation, to the transferee. The trans-
feree must accept these License Terms as a condition to the transfer.

HP Shrinkwrap License Terms v



Termination: HP may terminate your license upon notice for failure to comply with any of these
License Terms. Upon termination, you must immediately destroy the Software, together with all copies,
adaptations and merged portions in any form.

Export Requirements: You may not export or re-export the Software or any copy or adaptation in
violation of any applicable laws or regulations.

U.S. Government Restricted Rights: The Software and Documentation have been developed entirely
at private expense. They are delivered and licensed as “commercial computer software” as defined in
DFARS 252.227-7013 (Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227-7014 (Jun
1995), as “commercial item” as defined in FAR 2.101 (a), or as “Restricted computer software” as
defined in FAR 52.227-19 (Jun 1987) (or any equivalent agency regulation or contract clause), which-
ever is applicable. You have only those rights provided for such Software and Documentation by the
applicable FAR or DFARS clause or the HP siandard software agreement for the product involved.

vi  HP Shrinkwrap License Terms
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INTRODUCTION

Thank you for purchasing the HP Palmtop PC.
This pocket guide is your handy reference to the use of your palmtop PC while you are away

from your desk. It contains information complementary to the other user assistance materials

that are included in the box.

viii - Introduction



For Further Help

SEE
l. Setting up your HP Palmtop | Product Road Map, “Start Here”
s E BT 7 “HP Palmtop PC Tour” (HP CD-ROM)
2. Partnership with Desktop Product Road Map, “Start Here”
computer “HP Palmtop PC Tour” (HP CD-ROM)
3. Overview of the HP Palmtop H/PC Tour (Mobile Devices Explorer
PC programs Help menu)
4. Procedures for using the H/PC Online Help (Tap Help on the Start
programs menu, or tap the question mark on the tool
. bar.)
5. Tips & Troubleshooting Quick Guide to Pre-Installed Applications
Information (HP CD-ROM)
| 6. Unique HP Palmtop PC | HP CD-ROM
features :
7. Quick instructional printed Microsoft Windows CE “The H/PC
guide ) Companion”
8. Latebreaking news on HP Readme file in “Quick Guide to Built-in
Palmtop PC Applications” (HP CD-ROM)
9. Frequently Asked Questions HP Handheld Products Home Page at:
s . o e IR http://www.hp.com/handheld
10. Tips and tricks from other Microsoft Windows CE Home Page at:
Windows CE users, http://www.microsoft.com/windowsce
information about new
programs, and product support

For Further Help 1



A CLOSER LOOK AT THE HP PLAMTOP PC

EXTERNAL FEATURES — Top VIEW

Esc Button

Stylus

Upgradeable ROM Slot ( @ + Spacebar)

EXTERNAL FEATURES — SIDE VIEW

IR (Infrared) Port

CompactFlash Card Slot (in certain models)



EXTERNAL FEATURES — BoTTOM VIEW

Back-up

Basery Upgradeable
Compartment ROM Bay

Reset Button

Speaker

Serial Port

AC Adaptor Port

PC Card slot Main Battery

Compartment
PC Card
Eject Button



TRANSFERRING DATA

From the Palmtop PC to the Desktop PC
After establishing a connection between your HP Palmtop PC and desktop computer, the H/PC Explorer
window on the desktop displays the files and folders on the palmtop PC. This means that you can simply
drag and drop or copy files in H/PC Explorer to transfer data between the two machines.

To transfer files from your HP Palmtop PC to your desktop computer, use the Windows CE Explorer
window on the HP Palmtop PC to either drag and drop or cut and paste, to the desktop H/PC Explorer.

From the Desktop Computer to the Palmtop PC

To transfer a file from your desktop to the HP Palmtop PC, select it and drag it to a destination folder in
the H/PC Explorer window, or to the H/PC Explorer desktop shortcut icon. If you don’t want a copy of
the file to remain on your desktop PC, use the Edit menu Cut and Paste commands to move the file to the
H/PC Explorer window.

From Palmtop PC to Palmtop PC

To transfer files from your HP Palmtop PC to a second HP Palmtop PC:
1. Position the two palmtop PCs so that their infrared ports are aligned.
2. Be sure that both units are powered on.

3. Open Windows CE on the unit that is transmitting a file.

4. Tap on the name of the file to transmit.

5. Tap on Send/Receive File to transmit the file.

From earlier HP 300 series palmtop PCs to HP 360LX
Both the HP 300LX and HP 320LX runs on Windows CE 1.0. You can migrate your data from these
earlier palmtop PCs to the HP 360LX which runs on Windows CE 2.0.



To migrate data from Windows CE 1.0 to Windows CE 2.0:

15
2
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Connect the HP Palmtop PC and the desktop computer and establish partnership between the two.
Synchronize your earlier palmtop PC with your desktop computer using H/PC Explorer 1.0.
Perform a full backup of your data:

To back up data to the hard disk of your desktop computer:

* Select Backup/Restore from your desktop computer’s H/PC Explorer 1.0 Tools menu.

# [n the window that appears, in the Backup tab, select your preferred options.

*# Click Backup Now to initiate the process.
Take note of the directory in which your data has been saved.

. Take note of the Communications, Owner, and World Clock alarm settings on your palmtop PC. Also

note Options and User Preferences settings for third-party programs. (These settings are not
automatically restored.)

. Insert the Microsoft CD-ROM that came with your HP 360LX to install H/PC Explorer 2.0.
. Restore the data which you have backed up in step 2 into the HP 360LX.

* Select Backup/Restore from the Tools menu in H/PC Explorer 2.0.
* Click the Restore tab and click Restore Now.

. Perform a soft reset on the HP 360LX to complete the restoration operation.

* Remove the backup battery cover.
* Use a pen or tip of a straightened paper clip to press the red reset button and hold for
approximately 5 seconds.

. Synchronize your HP 360LX with the H/PC Explorer 2.0



From other HP Handheld products to Palmtop PC (HP PIM Translation Utility)

The HP PIM Translating Utility allows you to transfer your existing Phone Book and Appointment

Book data from HP 100LX/200LX Palmtop PCs and HP OmniGo 100/120 organizers to your HP Palmtop

PC. The translation process invloves the following:

1. Transfer the data from the HP 100LX/200LX palmtop PCs or HP OmniGo 100/120 organizers to the
desktop PC’s hard drive or a floppy disk using an HP connectiviy solution. (Refer to your existing
HP handheld device manual for more information. You will require a synch cable and desktop
connectivity software for the existing handheld product from which you are transferring data.)

2. The HP PIM Translation Utility installed on the desktop computer translates the PIM data files into
Schedule+7.0a application records.

3. You can then synchronize the updated Microsoft Schedule+7.0a records to the HP Palmtop PC using
the H/PC Explorer.

To install the HP PIM Translation Utility onto the desktop computer:

1. Insert the HP CD-ROM into the CD drive.

2. Click on the “Trial Software” button on the Main Page of the CD-ROM, then click on “Download” to
download the HP PIM Translation Utility.

To start the translation:

(Note: Copies of the Phone and Appointment Book data should already have been moved to the desktop
computer from the HP 100/200LX palmtop PCs or HP OmniGo 100/120 organizers.)

Launch the HP PIM Translation Utility application on your desktop computer to invoke the Welcome screen.

To translate Appointment Data:

1. Click on Appointments in the Welcome screen.

2. Specity the appointments data file to translate in the Open File dialog box that appears, then click OK.
3. If the file you specify is not a PIM database file of the appropriate type, you’ll get an error message.



4. Otherwise, the Appointment Book Translation Note screen appears.

5. The data translation progress screen appears, showing the progress of current translation activity.

6. When the translation has been successfully completed, a message appears. Click OK to return to the
Welcome screen.

An Appointment Translation Limitation

. Although the Appointment Book applications on the HP 100LX/200LX palmtop PCs and
HP OmniGo 100/120 organizers and the Calendar application on the HP Palmtop PC support
daily, weekly, monthly, and yearly repeated events, the Scheduler+ application supports
only daily and yearly repeated events. Since all translations go through Schedule+, there
is no direct mapping from earlier HP palmtop products to Scheduler+ for repeating weekly
and monthly events.

. As long as you do not edit imported repeating weekly or monthly events in Scheduler+ before
you synchronize them with the HP Palmtop PC, they will translate correctly into repeating
events on the palmtop PC. If, however, you have edited them in Scheduler+, they lose their
weekly/monthly attribute and are treated as single events.

To translate Phone Book Data:

1. Click on Phone Book in the Welcome screen.

2. Specify the phone book data file to translate in the Open File dialog box, then click OK.

3. If the file yvou specify is not a PIM database file of the appropriate type, you'll get an error message.

4. The Phone Book Translation Field Map screen appears.

5. See “Mapping Field Names,” below, for more information on mapping phone book fields.

6. Next the data translation progress screen appears, showing the progress of the current translation
activity. Click the Stop button to terminate the translation operation in progress.

7. When the translation has successfully completed, a message appears. Click OK to return to Welcome screen.



MAPPING FIELD NAMES

The HP PIM Translation Utility attempts to map the fields in your Phone Book data file to standard
fields in a Schedule+ record. As long as your Phone Book fields have standard names (that is, you have
not modified the Phone Book database field structure), the translation is straightforward. The suggested
mapping appears in a table in the Phone Book Translation Field Map screen:

. The left column shows the names of fields extracted from the Phone Book data file. (Only the
fields that have data are included.)

. The right column shows the names of Schedule+ fields.

. An arrow in the centre column indicates that the data in a Phone Book field in the left column

will be copied to the corresponding Schedule+ field in the right column. Note that multiple
Phone Book fields (for example, Address] and Address2) can be mapped to the same
Schedule+ field (for example, Business address).

. No arrow in the centre column indicates that there is no mapping and, therefore, the data will
not be copied.

Mapping a Name

The Name field in the Phone Book data file can be mapped in three ways in Schedule+

. If the name in the Phone Book data file is entered as Name |, Name2 [Name3] (that is, with a
comma after the first word), it is always mapped to the two name fields in Schedule+ with
Namel = Last Name and Name2 [Name3] = First Name.

. If the name in the Phone Book data file does not have a comma after the first word, you can
choose one of two options for its mapping:
* Last name/First name - (default) Namel [Name3] Name2 maps to Namel = Last Name and
[Name3] Name2 = First Name.



* First name/Last name - Name1 [Name3] Name2 maps to Namel [Name3] = First Name and
Name?2 = Last Name.

Adding a Mapping

If a field appears in the left column with no mapping (that is, no arrow in the centre column) select a field
name from the drop down list box of the Schedule+ field immediately to the right of the field whose
mapping you want to define.

When you complete the selection, the field name appears in the appropriate cell in the right column and a
mapping arrow appears on the centre column.

Changing a Mapping

If a field in the left column is mapped to the wrong field in the right column, change the mapping by
selecting a different Schedule+ field name from the drop down list box for the corresponding cell in the
right column.

Deleting a Mapping
If a field in the left column should not be mapped to anything, select (none) from the drop down list box
for the corresponding cell in the right column. The (none) option is not available for the Name field.

Reviewing Translation Status

After each translation is finished, whether it was completed successfully or was interrupted, the results are
written onto the Status screen. Click the Status button on Welcome screen to see the history of any translations
begun during the current execution of the HP PIM Translation Utility application.



BACK UP AND RESTORE

BACKING UP DATA

Although unlikely, it is possible to lose data on your palmtop PC. It is, therefore, always good practice
to save a backup copy of your data. You can back up and restore Calendar, Contacts, and Tasks data and
your Inbox messages to:

- the hard disk on the desktop computer via the H/PC Explorer

-a PC card

- a CompactFlash card

- the palmtop PC internal storage

USING THE DESKTOP COMPUTER
The process of backing up or restoring data on the destop computer is driven by the H/PC Explorer
software on the desktop computer.

To back up data to the hard disk of your desktop computer:

1. Connect the HP Palmtop PC and the desktop computer and establish partnership between the two.
2. Select Backup/Restore from your desktop computer’s H/PC Explorer Tools menu.

3. In the window that appears, in the Backup tab, select your preferred options.

4. Click Backup Now to initiate the process.

If you select “Automatically Back Up Upon Connecting”, the H/PC Explorer will automatically back up
any changes on the data on your palmtop PC whenever you connect to the desktop PC.

NOTE:
* Do not back up files from your palmtop PC to a temporary directory on your desktop PC. If you
do, the backup procedure will not work correctly and the integrity of your data will be compromised.



* Restoring data to your palmtop PC from your desktop computer replaces the existing data and, there-
fore, overwrites any changes you’ve made to the palmtop PC data since the last backup.

* After a restoration operation, you must disconnect and reset your palmtop PC. If you don’t, your
palmtop PC will not function properly and you will not be able to reconnect to your desktop computer
until the reset is completed.

To restore data from your desktop computer:

1. Select Backup/Restore from the Tools menu.

2. Click the Restore tab and click Restore Now.

3. Restart your palmtop PC to complete the restoration operation.

USING A PC CARD
The process of backing up or restoring data on a PC card is driven by the Database Backup option on the
HP Palmtop PC’s Control Panel.

! WARNING:
It is recommended that you use only PC cards which have been tested with your model of HP Palmtop
PC. Use of other cards is not recommended. For a list of recommended PC memory cards, refer to our
website at “http://www.hp.com/handheld”.

Before backing up or restoring data on a PC card, be sure that:
» all Information Manager applications are closed on the palmtop PC
« the palmtop PC is not connected to a desktop computer, or other serial device

To backup data on a PC Card:
1. Be sure that a PC card with sufficient storage is in the PC card slot on the palmtop PC.
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3.

Select the Backup tab on the Data Backup window.
Tap Back Up Data.

4. When asked to specify a file name to save to, specify the PC card folder and a file name. The database

backup file should have the extension * DBB.

To restore data from a PC card:

1

. Select the Restore tab on the Data Backup window.
2
3. In the Restore dialog that appears, specify the name of the database backup file to restore to the

Tap Restore Data.

palmtop PC, then tap OK. The default directory for this dialog is My Handheld PC(root); the default
file type is “Database Backup” (*.DBB). If a PC card or CompactFlash card is in the palmtop PC, the
default directory is PC card.

. After you have confirmed a backup storage file from which to restore the data, the Restore Data?

message appears. Tap Yes to proceed or No to cancel the operation and return to the Data Backup
screen.

. The Data Restore In Progress dialog appears next, providing status on the operation as it proceeds.
. When the restoration is successfully completed, a message appears to remind you that there may be

some database cleanup to do the next time you synchronize with the desktop computer.

USING A COMPACTFLASH CARD
The procedures are the same as that of PC cards.

USING INTERNAL STORAGE
The procedures are the same as that of PC cards except that you specify a folder and file on the palm-
top PC.



RESETTING

RESETTING
If your palmtop PC freezes up during operation, you may find it necessary to reset the device.
The two ways to reset the palmtop PC are the soft reset and hard reset.

| WARNING!
A soft reset causes any UNSAVED data to be lost.
A hard reset causes ALL data to be lost.

SOFT RESET
Remove the backup battery door and press the red reset button inside the compartment. Hold for 5 seconds.
The palmtop PC will restart automatically.

HARD RESET
Remove the main batteries and the backup batteries, wait for approximately 3 minutes, then reinsert them.
Remember, leaving the palmtop PC with no power causes ALL DATA TO BE LOST.



FREQUENTLY ASKED QUESTIONS

TIPS AND TROUBLESHOOTING

WHAT DOIDOIF ...

... the unit will not power on?

First make sure that the unit has fresh batteries and that adjusting the contrast has no effect. Then do a
reset as described earlier. If the unit still does not respond, it may need service.

... the unit powers off after it powers on?
The main batteries are very low. Replace the batteries immediately.

... my password does not work?

Although passwords are not case sensitive, there are some modes that may affect password entry. Try
retyping the password and toggling the NUM LOCK (FN + CTRL). If this does not work, do areset.

If you have forgotten your password, or if for some reason your palmtop PC has becqme corrupted and
pressing the reset button does not work, you must do a full reset, as described qm;her Pgafamzr[g a Sull
reset erases all files, programs, and other user information that you have emen’d. e

.. the system does not respond appropriately to stylus taps? :

Try recalibrating the stylus, as described earlier. First press “CTRL” + “ALT” + = rhen f()IIow the on-screen
instructions. You can also adjust double-tapping from the Stylus Properties window, as described earlier:

... I get the message “Can’t find filename [or one of its components]”” when I double-tap an icon?
If there is a small arrow in the lower left hand corner of the icon, it represents a Shortcut Link, and not
the actual file. Edit the shortcut properties or replace the shortcut, as outlined in Chapter 1, "Getting
Started”, in the Microsoft Handheld PC User’s Guide.



I get the error message “Recycle Bin Maximum Size Reached”"

you can change the amount of memory allocated to the Recycle Bin.

«.. I think the unit requires service? : L T
Contact one of the technical support numbers listed on the back of the card, “Contae 'g b'ewle -Packard
Worldwide,” which is included in the product box. Do not ship your computer for service without first

contacting a Hewlett-Packard office.

HOWDOTI...
... do a CAPS LOCK?
Press both “SHIFT” keys at the same time. When CAPS LOCK is on, an [A] appears in the toolbar.

... do a right mouse click?
Hold down the “ALT” key while you tap an item.

... get the time to appear on the taskbar?

1. On the Start menu, tap Settings.

2. In the Control Panel, double-tap the World Clock icon.
3. Tap the Date & Time view of the World Clock.

4. Select View, then Show Clock in Taskbar.

... check battery levels?
Look at the battery status icon on the right side of the taskbar and/or the Battery Status tab on the Power
Properties window, as described earlier.



... minimize a document or application?
Tap the application button on the taskbar. Tap again to maximize, as described earlier.

ﬁn(;!' out how much memory is available for storage and/or applications?
1. On the Start menu, tap Settings.

2. In the Co .tmf Panel, double-tap the Systems icon.

3. Look at the Memory tab.

... find out information about my unit like memory, operating system, and so on?
1. On the Start menu, tap Settings.

2. In the Control Panel, double-tap the Systems icon.

3. Look at the General tab.

... view file name extensions in Windows CE Explorer?

From the View menu of the tool bar choose Options, then clear the Hide File Extensions check hox. :

... set an alarm for a more than a day in advance?

The World Clock Alarm function is only intended for daily alarms. For appointments thaf happen once,
or for greater flexibility with repeating alarms, you may wish to use the Calendar or Task applications.

... use point sizes greater than 24 in Pocket Word?

Although font sizes between | and 1638 are allowed in Pocket Word for compatibility with Microsoft

Word, the largest supported font size on the palmtop PC is 24.

... increase the speed of data transfer to and from my desktop PC?

Youmay be able to increase the speed of data transfer if your desktop PC supports speed rates higher than

19,200 baud. From the H/PC Explorer software on the deskiop, review the help topic “Tips, increasing

speed of data transfer between your HPC and desktop computer.”

R " v R T T



... use Pocket Internet Explorer to FTP files?
Pocket Internet Explorer supports only the HTTP URL format, not FTP

... shut down my palmtop PC using Windows CE?
Windows CE has a Suspend option but no Shut Down option. Press “FN”, then spacebar to power off
the HP Palmtop PC.

... upgrade the ROM and/or RAM?
Upgradeable ROM units are sold separately as accessories, as described in the HP Solutions Guide that is
included in the product box. RAM in the HP Palmtop PC is not Upgradeable.

... get a list of modems and PC Cards that are supported on my H/PC?
For a detailed list, you can contact us on the Web at:hup:/iwww.hp.com/handheld/thirdparty_soln/
product_info/3000x_hw.html

... find out the answers to other frequently asked questions?
htp:/fwww.hp.com/handheld/getting _help/support/palmtops/300Ix_faq.html
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